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About Enterprise Edge Attendant Console

Enterprise Edge Attendant Console is an application that provides centralized
management and call activity reporting capability to a business. It runs on on
more Pentium®-class personal computers (PCs).

With Enterprise Edge Attendant Console, a telephone attendant uses a graph
user interface. You can customize the way Enterprise Edge Attendant Conso
set up to best suit your company’s call management requirements. The atten
uses the interface to:

• originate calls

• answer and manage multiple calls

• view a company’s name before answering a call

• record, add and change caller information for future use

• quickly access information about a caller

• transfer calls to employees or their Enterprise Edge Voice Messaging exte

• send the caller’s name to the employee’s Enterprise Edge telephone disp

• park calls and page employees

• view, in a Directory, information about your company’s employees such as
their extension number, employee status and telephone status

• create and print reports showing how incoming calls are handled

• view the status of all extensions in the company’s Enterprise Edge server

For information about using these features, refer to the Enterprise Edge Attendant
Console User Guide.

About this guide
This document describes how to install and set up an Enterprise Edge Attend
Console system for use in your company.

The instructions in this guide are designed for experienced PC users who are
familiar with client/server software installations, Enterprise Edge technology a
Local Area Network (LAN) technology.

If you encounter problems or require definitions of error messages during 
installation, refer to Troubleshooting on page 33.

1
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Conventions
The term LAN refers to a Local Area Network that supports TCP/IP.

Reference documents
You may need to refer to the following documentation:

• the Enterprise Edge Operations Guide and Enterprise Edge Server Guide that 
comes with your Enterprise Edge server

• the Enterprise Edge Voice Messaging installation and set up documentati
that comes with your Enterprise Edge product package

• the Enterprise Edge Attendant Console User Guide
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02
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Preparing for installation

Before you install Enterprise Edge Attendant Console:

• read the section How Enterprise Edge Attendant Console works on page 7.

• read the section Company model on page 8.

• review the requirements. Refer to Requirements for Enterprise Edge Attenda
Console on page 8.

• make sure your Enterprise Edge telephone system is installed properly an
functioning correctly. Refer to Preparing the PC environment on page 11.

After you complete these steps, read Installing Enterprise Edge Attendant Consol 
on page 15 before you proceed.

How Enterprise Edge Attendant Console works
Enterprise Edge Attendant Console is a client/server software system consist
the following three components:

• Enterprise Edge Attendant Console Server component

• Enterprise Edge Attendant Console Attendant component

• Enterprise Edge Attendant Console Reports component

Enterprise Edge Attendant Console Server component
The Server component supports the Attendant component running on PCs 
connected through a Transmission Control Protocol/Internet Protocol (TCP/IP
based LAN.

The Server component also uses this interface to request Enterprise Edge se
call processing features.

The Server component communicates with the Attendant component(s) using
industry standard TCP/IP protocol, passing information about call arrival, 
telephone status and the database to the Attendant component(s) as require
also handles Attendant component requests for Enterprise Edge server opera

The Server component maintains and collects call-processing information in 
on-line database for use in call handling and maintains call detail information
reporting purposes.

2
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Enterprise Edge Attendant Console Attendant component
The Attendant component controls the graphical user interface for operating 
Enterprise Edge Attendant Console. The Attendant component displays incom
call information, Enterprise Edge telephone status, directory information and 
disposition requests for enhancing the telephone attendant’s productivity and
responsiveness.

Note: The Attendant component must be installed on all attendants’ PCs.

The Attendant component communicates with the Server component using TC
to perform call handling on the Enterprise Edge server and to access and ma
the server database.

Enterprise Edge Attendant Console Reports component
The Reports component provides the capability to display and print the 
information in the call processing database that is maintained by the Server 
component. The Reports component is installed automatically with the Attend
component and it accesses the server database using TCP/IP.

Company model
You can set up a Enterprise Edge Attendant Console system with a networke
model. In a networked model, one or more attendants manage the calls for a
company with their PCs connected through a network to the Server compone

To set up more than one attendant to manage a company’s calls, you can co
the Server component to additional PCs through a LAN. The Attendant compo
can be installed on the same PC as the Server component as well as on othe
attached PCs. An Attendant component license is required for each additional
of the Attendant component.

Requirements for Enterprise Edge Attendant Console
Install the Reports component on the same PC as the Attendant component.

When you install the Server component, the Attendant component is automat
installed at the same time. This occurs even when the attendant position is o
different PC. This is so that you can easily check the Enterprise Edge Attend
Console installation from the Enterprise Edge server. After you perform the ch
you can shut down the Attendant component at the Enterprise Edge server.

Before you install Enterprise Edge Attendant Console, check that your equipm
meets:

• the Enterprise Edge telephone system requirements.

• the PC system requirements for the Attendant component. 
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02
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Enterprise Edge telephone system requirements

Enterprise Edge Attendant Console operates with the Enterprise Edge server

The Enterprise Edge server must be equipped with trunk modules capable of
receiving Caller ID information. You must also subscribe to the Caller ID 
functions through the local telephone company.

Make sure that each attendant has an Enterprise Edge two line display displa
telephone and a headset.

The Enterprise Edge Attendant Console Attendant component can monitor th
following telephones:

• Enterprise Edge two line display

• Enterprise Edge one line display

• 2500 - type (industry standard)

• Enterprise Edge Companion wireless

Enterprise Edge Attendant Console supports Visual Call Announcing and Co
on Enterprise Edge two line display telephones.

PC system requirements for installing the Attendant component on a client PC

If you install the Attendant component on a PC, you require the following PC 
hardware and software:

Minimum hardware requirements:

• Pentium®-based PC

• 32 MB of memory or greater

• 10 MB available disk space (total disk space required for either the stand-a
model or networked model)

Note: Additional disk space may be required for the server database. The
required size of the server database depends on the call volume an
frequency of call record deletion.

• Local Area Network connection for client software installation

• SVGA monitor with a minimum resolution of 800 x 600 and .28 dot pitch o
smaller

• keyboard and mouse supported by Windows

• printer supported by Windows (optional, for report printing)

• PCI - bus Network Interface Adapter, 10/100 MB Ethernet 

Note: Excludes NE2000-Class cards

Software requirements:

• Windows® 95, Windows® 98 or Windows NT® 4.0 Operating System
P0908543 Issue 02 Enterprise Edge Attendant Console Set Up and Operation Guide 
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PC system requirements for Unified Manager
Minimum hardware requirements:

• Win NT workstation running on P133 or higher CPU (or compatible)

• 64 MB of memory or greater

• 10 MB available disk space

Note: Additional disk space may be required for the server database. The
required size of the server database depends on the call volume an
frequency of call record deletion.

• Local Area Network connection for client software installation

• SVGA 17" monitor with a resolution of at least 1024 x 768 and .28 dot pitc

Software requirements:

• Windows® 95, Windows® 98 or Windows NT® 4.0 Operating System

Either:

• Netscape Communicator 4.5 or greater with these Advanced settings:
Java: on
Cached document comparison: every time

or

• Internet Explorer 4.0 or greater with JVM (Java Virtual Machine) version 5
(build 5.0.0.3167 or greater) and these Temporary Internet File settings:
Check for newer versions: every visit
Advanced: Java VM
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02
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Preparing the PC environment

To prepare the PC environment:

• ensure the LAN is installed and functioning properly. Consult your network
administrator for assistance if necessary.

Enterprise Edge Attendant Console uses TCP/IP to communicate between th
Server component and the Attendant component. This protocol must be insta
on every PC that runs Enterprise Edge Attendant Console. This includes PCs
are installed as stand-alone. Follow the steps in Windows networking for an 
attendant on page 11 and Windows networking for an attendant on page 11.

Windows networking for an attendant
Enterprise Edge Attendant Console uses the industry standard TCP/IP protoc
communicate between the Enterprise Edge server and the Attendant compon
This means that you need the Windows Network component for all Enterprise
Edge Attendant Console PCs, including those without a LAN adapter.

The Enterprise Edge Attendant Console installation process does not install t
Windows Network component. For instructions on installing the Windows 
Networking component, refer to your network or Windows documentation.

To check that the Windows system is correctly set up before you install the 
Enterprise Edge Attendant Console Attendant component:

Note: If your company has a network administrator, check with your 
administrator before changing any network configuration parameters.

1. Start Windows on the Attendant PC.

2. On the Windows taskbar, click Start, point to Settings and then click Control 
Panel.

3. Double-click the Network icon.
The Network window opens with the Configuration tab displayed.

4. Check that TCP/IP is on the list of installed network components. If not, c
the Add button to install this protocol using the Windows installation 
procedures.

5. Double-click TCP/IP.
For Attendant PCs, check with your network administrator that the IP Addr
option is consistent with other PCs on the network. Normally the Obtain a
address automatically option is selected.

6. Install any components that are not present from the Windows installation
package or consult your network administrator for assistance. When these
items are checked, close the windows.

3
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12  Preparing the PC environment
Checking the network components before installation

Before you install Enterprise Edge Service over the network, check that the 
required network components are installed on the Attendant PC.

Note: If your company has a network administrator, check with your 
administrator before changing any network configuration parameters.

To check for required network components on the Attendant PC:

1. Start Windows on the PC.

2. On the Windows taskbar, click Start, point to Settings and then click Control 
Panel.

3. Double-click the Network icon.
The Network window opens with the Configuration tab displayed.

4. Click the File and Print Sharing button.
The File and Print Sharing dialog box appears.

5. Select both the options in the File and Print Sharing dialog box.

6. Click the OK  button.
The File and Print Sharing dialog box closes.

7. Click the OK  button on the Network window.
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02
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Windows networking for reports
When Enterprise Edge Attendant Console processes incoming calls, it stores
information about each call in a centralized database on the server PC. The R
component uses this database to prepare different types of call reports. If the
Reports component is executed on a PC, you must first locate the centralized
server database from the PC running the reports. Refer to Configuring the Reports 
component on page 27.

To support operation of the Reports component on a networked Attendant PC

• Check that the File and Print Sharing component is present and enabled.

To share the server database with the Reports component over the network:

1. On the Windows taskbar of the Enterprise Edge server, click Start, point to 
Find and then click Files or Folders.
The Find: All Files dialog box appears.

2. In the Named box type consoleservicedb.

3. Click the Find Now button.

4. Right-click the consoleservicedb folder and click Sharing.
The ConsoleServiceDB Properties dialog box opens.

5. Select the Shared as option.

6. Click the Permissions button.
The Access Through Share Permissions dialog box opens.

7. From the Type of Access list box, select Full Control .

8. Click the OK button.
A message appears asking if you want to include DOS users.

9. Click the Yes button.

10. Click the Apply  button.
P0908543 Issue 02 Enterprise Edge Attendant Console Set Up and Operation Guide 
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Installing Enterprise Edge Attendant Console

To install Enterprise Edge Attendant Console, complete each of the following
steps in order. Each step is described in detail in this guide.

1. Ensure you have all the contents of the Enterprise Edge Attendant Conso
package.

2. Ensure all telephone system, PC and network requirements are met. Refe
Preparing the PC environment on page 11.

3. Install the Attendant component by following the procedures in Installing the 
Enterprise Edge Attendant Console Attendant component on page 15.

If you encounter error messages during the installation process, refer to 
Troubleshooting on page 33.

Installing the Enterprise Edge Attendant Console Attendant component
On the Attendant PCs, install the Enterprise Edge Attendant Console Attenda
software. To install the Enterprise Edge Attendant Console Attendant softwar
an Attendant PC:

1. Exit any Windows programs that are running.

2. On the taskbar, click the Start button, point to Find and then click Computer.
The Find: Computer dialog box appears.

3. In the Named list box, type the name of the Enterprise Edge server, or sele
the Enterprise Edge server from the list. If you do not know the name, ask 
System Administrator.

4. Click the Find Now button.
The icon of the computer appears in the list below.

5. Double-click the computer icon.
The computer’s window opens.

6. Double-click the NortelDT  folder.

7. Double-click the Attendant Console folder.

8. Double-click the Setup.exe file.
The Enterprise Edge Attendant Console Installation dialog box appears.

4
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9. Click the button labeled with the language you want to use. 
The Enterprise Edge Attendant Console Welcome dialog box appears.

10. Click the Next button.
The Choose Destination Location dialog box appears.

11. Click the Next button to accept the default location. To change the director
location, click the Browse button, choose another directory location and the
click the Next button.
The Select Program Folder dialog box appears.

12. Click the Next button to accept the default Program Folder name: Enterpri
Edge Attendant Console. To change the folder name, click the name you c
in the Existing Folders list box or type a different name in the Program 
Folders box.

13. Click Attendant to install the Attendant component and then click the Next 
button.
As installation proceeds, messages are displayed that indicate the progre
the installation. The Setup Complete dialog box appears with the option “Y
want to restart my computer now.” selected.

14. Click the Finish button.
Your computer restarts.

For Software Keycode information, refer to the Enterprise Edge Software 
Keycode Installation Guide.
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02



Configuring Enterprise Edge Attendant 
Console

After you install Enterprise Edge Attendant Console, you must configure its 
components. To configure Enterprise Edge Attendant Console, you must:

• configure the Server component

• configure the Attendant component

• configure the Reports component

Configuring the Server component
To configure the Server component:

1. Start your Internet browser.

2. In the Address bar, type the IP address of the Enterprise Edge server.
The default address is 10.1.1.1
If you don’t know the IP address consult your Installer or Administrator.
The Enterprise Edge window opens.

3. On the left pane click the key symbol beside Services and then click 
Attendant Console.
The Attendant Console window opens.

5
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4. In the VM Extension box type the extension number for Enterprise Edge 
Voice Messaging.
To determine the Enterprise Edge Voice Messaging extension number, pr
ƒ·°fion the telephone that is connected to the system. The 
Enterprise Edge Message extension number appears on the telephone’s 
display.

5. In the Stations option, the default setting for Rediscover on next restart is 
No. Do not change the setting to Yes unless you have made significant cha
to your phone system.

6. If you want to set Logging options, refer to Setting Logging options on page 
18.

7. Close the browser window to finish configuring the Server component.

Setting Logging options
Do not set the Logging options unless you are having problems with your sys
and you want to analyze them. If you enable Logging, you can examine the lo
information about system problems. The Logging options have seven setting
let you control logging.

To enable logging:

1. In the Level box type a number between 0 to 60.
This number represents the level of detail you want to log.

2. Set To file to Yes to save the log to a file.

3. Set CP events on to Yes to log Computer Telephony Engine events.

4. Set Device events on to Yes to log phone events such as off-hook, on-hook a
Call Forward.

5. Set Response events on to Yes to log how Enterprise Edge Attendant Conso
interprets events on the system.

6. Set Session events on to Yes to log system events other than those covered
Device events and Response events.

7. Set System events on to Yes to log events reported through Windows NT, suc
as general protection faults that are related to Enterprise Edge Attendant 
Console or Windows NT.

8. Close the browser window to enable logging.
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02
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Configuring the Attendant component
You must set up each PC that has the Attendant component installed to handl
either as a full-time main attendant, part-time main attendant, backup attenda
overflow attendant or assistant attendant.

Starting the Attendant component for the first time
After you configure the Server, you can start and set up the Attendant compo

To start the Attendant component for the first time:

1. On the Windows taskbar, click Start, point to Programs, point to Enterprise 
Edge Attendant Console and click Attendant.
The Attendant component starts. The Enter Attendant Options dialog box 
appears the first time you start the Attendant component after installation.

2. In the Attendant Extension box type the extension number for the attendan

3. If the network has more than one Enterprise Edge Attendant Console ser
running, click the server ID box and type the server ID for the server you wa
to use. 

4. Click the OK  button.
The Tip of the Day dialog box appears over the Enterprise Edge Attendan
Console Attendant window.

5. Click the Close button to close the Tip of the Day window.
The Tip of the Day window closes and the Enterprise Edge Attendant Con
window remains open.

Starting the Attendant Component
After you start the Attendant component the first time, follow this procedure to
start the Attendant component subsequent times.

To start the Attendant component:

1. On the Windows taskbar, click Start, point to Programs, point to Enterprise 
Edge Attendant Console and click Attendant.
The Attendant component starts.
P0908543 Issue 02 Enterprise Edge Attendant Console Set Up and Operation Guide 
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Quitting the Attendant component
You can quit the Attendant component whether the Attendant component win
is visible or minimized.

To quit the Attendant component if the window is visible:

1. On the File menu click Exit
or

1. Click the Close button (marked with an X) in the upper right corner of the 
Attendant window.

To quit the Attendant component if the window is minimized:

1. Right-click the Attendant component button on the taskbar.

2. Click the Close button.

Types of Attendant setups
You must configure each PC that has the Attendant component installed to h
calls either as a main attendant, overflow attendant, backup attendant or ass
attendant.

Full-time main attendant setup

The full-time main attendant is a telephone operator configuration where the 
Attendant window is always visible. You can define a number of full-time 
attendants. Every Attendant component must have the server ID and Attenda
extension options configured properly for the Attendant component to functio
The server ID tells the Attendant component where the Enterprise Edge Atten
Console Server component is located. The Attendant extension setting tells t
Attendant component which Enterprise Edge telephone belongs to the attend

After you define the settings, the Attendant component makes incoming calls
the attendant’s telephone appear as a yellow Ringing Loop button on the Atte
window. If the attendant’s telephone is programmed to receive all incoming ca
for the company (main attendant) the Enterprise Edge Attendant Console 
Attendant component also displays the calls.

To receive and make telephone calls, the Attendant component requires a 
telephone extension associated with this component. The extension must be a
extension on the Enterprise Edge server and must be the telephone at the 
attendant’s desk.
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02
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To set or change the attendant’s extension:

1. Click Tools and then click Options.
The Options dialog box appears with the Options tab displayed.

2. At the Attendant option, in the My Extension box, type the extension numbe
of the attendant’s Enterprise Edge telephone.

Part-time main attendant setup

The part-time main attendant is an attendant that can answer incoming calls 
perform additional functions on the PC, such as word processing.

The difference between the full-time main attendant setup and the part-time m
attendant setup is that part-time has additional Attendant options that allow 
notification of incoming calls when the Attendant component is minimized. Re
to Full-time main attendant setup on page 20 and Setting up other Attendant 
features on page 24.

Backup attendant setup

A backup attendant is an attendant position that receives calls that are redire
from some other attendant position. The backup attendant can also operate a
main attendant or assistant attendant, or any combination of the attendant typ

Note: As with all Attendant component setups, you must set up the server ID
Attendant extension options from the Options dialog box. After you set
the options, the Attendant component displays all incoming calls that ar
on the attendant’s Enterprise Edge telephone.

Each Attendant PC that is originally set up to receive incoming calls must be s
to redirect the calls to the backup Attendant PC.

Note: Calls can be redirected to another Enterprise Edge Attendant Console
attendant or any Enterprise Edge Voice extension.

If the attendant needs to leave their position, they activate the backup attend
position by clicking the OUT button on the Attendant window. This button 
indicates that the attendant is not at the station and that all calls are diverted 
specified backup position. After clicking the OUT button, the attendant can 
complete the calls currently in progress on the Attendant window. New calls 
appear at the position, but also appear at the backup position. Even though t
attendant is out, the Attendant component can process calls, if required.

To set up the backup attendant:

1. Click the Tools menu and then click Options.
The Options dialog box appears.

2. At the Redirect calls to option, in the Extension box, type the backup 
attendant’s extension number.
P0908543 Issue 02 Enterprise Edge Attendant Console Set Up and Operation Guide 
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3. To control call redirection, on the Attendant window click Attendant and 
select either In  or Out.

4. Click the OK  button.

Overflow attendant setup

An overflow attendant receives calls that are redirected from another attenda
position if there are more incoming calls than Loop buttons on the other Atten
component. For example, if a main attendant is already handling six incoming
calls, the next call is redirected to the overflow attendant until one of the main
attendant’s six Loop buttons is free.

The overflow attendant can also operate as a main attendant, an assistant att
or any combination of the attendant types.

Note: As with all Attendant component setups, you must set the server ID an
Attendant extension options from the Options dialog box. After you ha
set the options, the Attendant component displays all incoming calls th
arrive on the attendant’s Enterprise Edge telephone set.

If you set up an Attendant PC as the overflow, each Attendant PC that is set 
receive incoming calls must be set up to redirect calls to the overflow Attenda
PC whenever overflow conditions exist. You need to activate the overflow fea
at each Attendant PC.

Note: Calls can be redirected to another Enterprise Edge Attendant Console
attendant or any Enterprise Edge extension.

If the overflow condition (all Loop buttons in use) occurs on the Attendant 
position, the Loop overflow indicator in the Attendant status bar turns on and th
overflow call is diverted to the specified overflow extension.

To define the overflow extension:

1. Click the Tools menu and then click Options.
The Options dialog box appears.

2. At the Redirect calls to option, in the Extension box, type the overflow 
attendant’s extension number.

3. Select Call overflow occurs to redirect calls when all of the main attendant’s
Loop buttons are busy with calls.

4. Click the OK  button.
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02
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Assistant attendant setup

An assistant attendant provides call coverage for one or more extensions in t
system. This means that you can set up the Attendant so that it monitors all 
incoming calls to specified extensions. Since the assistant typically uses a PC
other work, Enterprise Edge Attendant Console alerts the assistant without 
requiring that the Attendant window is always visible on the system.

To set up an assistant attendant:

1. In the Options dialog box, select the Assigned extension rings option.
The Call Notification dialog box appears to inform the assistant that there i
outside call for an Assigned extension.

Use the Assigned feature when an employee wants an assistant attendant, suc
an administrative assistant, to answer the employee’s calls.

Note: Only calls that originate from outside the Enterprise Edge server appea
the assistant attendant’s window. Internal calls from an extension to an
assigned extension do not appear on the assistant attendant’s window

Enable the Assistant function by copying extensions to the Assigned list on th
Assigned tab of the Options dialog box.

To add or remove an assistant attendant’s assigned extensions:

1. Click Tools in the Main menu and then click Options.
The Options dialog box appears.

2. Click the Assigned tab on the Options dialog box.

To add an extension, click the extension you want in the All  extensions list and 
click >> to copy it to the Assigned extensions list.

To remove an extension from the Assigned extensions list, click the exten
number in the Assigned extensions box and click <<.

3. Click the OK  button.

You can view assigned extensions at any time by clicking the Assigned tab in the 
Directory options of the Attendant window.
P0908543 Issue 02 Enterprise Edge Attendant Console Set Up and Operation Guide 
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Setting up other Attendant features
You can assign Attendant features for the different set ups through the Option 
dialog box.

To set up other Attendant features:

1. On the Tools menu, click Options.
The Options dialog box appears.

The Options tab is displayed when the Options dialog box opens. The Option
contains the following options.

Option Description

Pop “Call Notification” dialog 
box when

sets the Call Notification dialog box to pop onto the screen.

Restore minimized Attendant 
screen when

sets whether or not the Attendant window is restored when 
call is answered on your extension.

Redirect calls to sets the overflow or backup attendant.

Server displays the name of the server. If there is more than one 
server you can manually enter the server name.

Attendant displays the attendant’s extension. You must manually ente
this during setup

Transfer Options disables Enterprise Edge Message and/or link transfer 
options.

Table 1: Functions of the Options tab options
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02
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Notifying the attendant of incoming calls

There are two ways an attendant can be notified of incoming calls:

• by the Call Notification dialog box. The attendant is notified of incoming ca
with a Call Notification dialog box. The attendant can answer the call by 
clicking the Take button on the dialog box or the attendant can ignore the 
and allow another attendant to answer it.

• by a Ringing Loop button. When the window is visible (not minimized), the
Call Notification dialog box does not appear. The attendant is notified of an
incoming call by a Ringing Loop button.

To activate call notification:

1. At the Pop “Call Notification” dialog box when option, select either:

Assigned extension rings - The attendant is notified of calls to the assigned
extensions.

or

My extension rings -The attendant is notified when their own extension has
incoming call.

If both check boxes are clear, the attendant is not notified of calls when th
window is minimized.

Automatically restoring the Attendant window when a call comes in

The Attendant window is normally minimized or under another window in a pa
time attendant environment. The attendant can restore the screen by clicking
Enterprise Edge Attendant Console Attendant button in the Windows taskbar
quicker method is to set the Attendant window to restore automatically.

The Attendant component can automatically restore the window when the 
attendant’s extension goes Offhook (“active”). This ensures the attendant can
access the Attendant window without having to manually restore it.

To set the Attendant window to restore automatically:

1. Click the Tools menu and then click Options.
The Options dialog box is displayed.

2. In the Restore minimized Attendant screen when option, select the Call 
answered on Attendant extension check box.

The window is restored when the attendant uses the extension to make o
answer a call.
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Saving the Attendant component options

1. Click the OK  button to save the changes you made on the Options dialog 
or click the Cancel button if you made no changes or do not want to save t
changes.
The Attendant options are operational immediately after saving the chang

Selecting extensions

The attendant can use the Selected tab to select extensions from the director
is useful if the attendant wants to direct their incoming calls to a limited numbe
extensions.

To display a selection of extensions in the Directory list of the Attendant wind

1. On the Attendant menu click Tools and then click Options.
The Options dialog box is displayed.

2. On the Options dialog box click the Selected tab.

To add an extension, click the extension you want in the All extensions list and 
then click >> to copy it to the Selected extensions list.

To remove an extension from the Selected extensions list, click the extens
number in the Selected extensions list and click <<.

3. Click the OK  button to return to the Attendant window.

Setting Transfer options for Enterprise Edge Voice Messaging and linking

If your Enterprise Edge server is not connected to a Centrex switch and or is 
connected to Enterprise Edge Voice Messaging, you can disable the Link Transfer 
and or VM Transfer buttons on the Attendant window.

To disable the Transfer Options:

1. On the Main menu click Tools and then click Options.
The Options dialog box is displayed. The Transfer Options options are in the 
bottom right of the dialog box.

2. Select the Disable VM Transfer check box to disable the VM Transfer butto
or
select the Disable Link Transfer check box to disable the Link Transfer 
button.

If they are unavailable, the buttons appear dimmed on the Attendant window.
can re-enable the buttons by clearing the check mark from the appropriate ch
box.
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02



Configuring Enterprise Edge Attendant Console  27

 

dge 
et up 

pear 
g call 
Starting the Reports component
Although the Reports component is automatically installed with the Attendant
component, you can start it or quit it independently.

To start the Reports component from the Attendant component:

1. On the Tools menu click Reports.
The Reports component starts in a separate window.

To start the Reports component from the Start menu:

1. On the Windows taskbar click Start, point to Programs, point to Nortel 
Networks, point to Attendant Console and then click Reports.
The Reports window opens.

Configuring the Reports component
The first time you start the Reports component, you must locate the server 
database, called consoleservice.mdb, on the Enterprise Edge server. The 
Enterprise Edge server database is in the directory named consoleservicedb. The 
entire path name is:

D:\Data Files\NortelNetworks\Attendant Console\consoleservice.mdb

Note: D: indicates the drive letter, which may vary according to the computer.

Quitting the Reports component
To quit the Reports component:

1. Click the File menu and then click Exit
or
Click the Close button in the upper right corner of the Reports window.

Networked operations
Before you install Enterprise Edge Attendant Console, set up the Enterprise E
telephone system so that calls arrive at the appropriate extensions. You can s
Enterprise Edge Attendant Console in a variety of network situations. The 
following are two examples of networked operations:

Example - All incoming calls go to two or more attendants

Two or more Enterprise Edge telephones are set up so that incoming calls ap
on the telephones at the same time. The first attendant to answer an incomin
connects to the caller. As soon as an attendant answers the call, the other 
attendants’ telephones stop ringing.
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The first step is to set up the attendant telephones. Install the Attendant comp
on each of the Attendant PCs and set them up as main attendants. Each inco
call appears on the Attendant window of each Attendant PC. The first attenda
answer a call connects to the caller. The answered incoming call disappears 
the other attendant’s windows.

Example - Incoming calls are divided between two or more attendants

The Enterprise Edge server incoming trunks are divided between two or more
telephones. Each attendant extension is programmed so that only a portion o
incoming calls appear at the telephone. With two attendants, for example, ha
the extensions ring at one attendant telephone (Attendant A) and the other ha
the other attendant telephone (Attendant B).

After you set up the telephones for the desired attendant setup, you can insta
Enterprise Edge Attendant Console. As in the previous example, you must se
the Attendant component as a main attendant on each of the Attendant PCs.
only difference is that in this example the overflow feature must be set at eac
Attendant PC. This means A’s extension must be set to overflow to B’s and B
must be set to overflow to A’s.

Verifying Enterprise Edge Attendant Console installation
You must verify Enterprise Edge Attendant Console installation after installati
and setup.

To verify that the installation is successful:

1. On the PC that has the Attendant component installed, click the Attendan
taskbar button to maximize the window. If the Attendant component is not
running, start the component.

To start the Attendant component:

On the Windows taskbar, click Start, point to Programs, point to Enterprise 
Edge Attendant Console and then click Attendant.

2. Press one of the intercom buttons on the attendant’s Enterprise Edge tele
and check that the telephone status icon of the attendant’s extension in th
tab of the Attendant’s Directory shows that the telephone is off-hook.

3. In the Directory  list, click the Full  tab and click the extension icon of a 
telephone that is physically located near the Attendant’s telephone. Check
the Target box contains the Directory information for that extension.
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4. Click the Call button. Check that the Attendant extension icon indicates Off-
hook, the first Loop button indicates Active, and the Target extension is 
audibly ringing. Click the Release button to end the call.

5. Go to another Enterprise Edge telephone and obtain an outside line by pre
an external line button or pressing an intercom button and entering the lin
pool access code.

6. Simulate an incoming call by dialing the main outside telephone number o
Enterprise Edge server. On the Attendant window, check that a Loop butt
indicates Ringing and that the Caller ID information, if set up, displays nex
the Loop button.

7. Click the Loop button. Check that the button changes from Ringing to Active 
and that the attendant’s extension is connected to the originating telephon
Check that the Caller Information  option has Caller ID information. If 
Enterprise Edge server Caller ID hardware is not installed or if you do not
subscribe to Caller ID services, the Caller ID Information  boxes are empty.

8. In the Name box in the Caller Information  option, select or type a name if 
none is present.

9. Click another extension in the Directory list and click the Transfer button.

10. Check that the incoming call leaves the attendant’s extension and the sel
extension starts to produce an audible announcement tone. Also check th
name entered in the Name box appears on the first line of the telephone displ
and display buttons on the second line.

11. Press the Talk display button on the called extension and check that a voic
connection is made to the originating telephone.

The Server component and the Attendant component installations are now 
verified. If any of the steps do not occur properly, refer to Troubleshooting the 
Server component on page 33 or Troubleshooting Attendant component 
installation on page 37 to check for installation errors.

If you are installing a networked model, you also need to check the Attendan
component installation on all of the Attendant PCs.
P0908543 Issue 02 Enterprise Edge Attendant Console Set Up and Operation Guide 



30  Configuring Enterprise Edge Attendant Console
Enterprise Edge Attendant Console Set Up and Operation Guide P0908543 Issue 02



r of 

 

rver, 

m 
Upgrading Enterprise Edge Attendant 
Console

You can add additional Enterprise Edge Attendant Console attendants.

Adding additional Enterprise Edge Attendant Console attendants

If you find that the call traffic is too high to be handled by your current numbe
attendants, your company can purchase additional Attendant licenses in 
increments of one to a maximum of five attendants. To register the additional
Attendant licenses, refer to the Enterprise Edge Software Keycode Installation 
Guide.

Removing Enterprise Edge Attendant Console
To remove the Enterprise Edge Attendant Console software:

1. Shut down all of the Enterprise Edge Attendant Console components (Se
Attendant and Reports).

2. On the Windows taskbar, click Start, point to Settings and click Control 
Panel.

3. Double-click the Add/Remove Programs icon .

4. Click Enterprise Edge Attendant Console.

5. Click the Add/Remove button.

The files associated with Enterprise Edge Attendant Console are removed fro
your computer hard drive. Complete the above steps on each PC that has 
Enterprise Edge Attendant Console installed.

6
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Troubleshooting 

This section contains solutions for problems that can occur while you install 
Enterprise Edge Attendant Console. It includes:

• Troubleshooting Server component

• Troubleshooting Attendant component installation

• Troubleshooting Reports component installation

Troubleshooting the Server component
This section contains solutions to problems that can occur while you install or
the Server component.

If problems occur on the Server component, log the Server activity and exam
the log for error messages. For information on how to set logging options, se
Setting Logging options on page 18.

Logging Server component activity
The Server component window allows you to choose optional functions of the
Server component. These functions can help diagnose Server component 
problems. They are:

• Saving the server log file to disk

• Changing the level of logging information to be displayed

For information on changing these options, see Setting Logging options on page 
18.

Saving the server log file

If you activate the Log to file command, the server log file is saved as a file na
“ConsoleServer.log” in the server directory.

Note: If you save the Server log file, the ConsoleServer.log file continues to g
and take up disk space. Make sure you turn this feature off when you 
finished troubleshooting the Server component.

For information on changing these settings, see Setting Logging options on page 
18.

Changing the amount of logging information displayed

You can change the level of amount of the logging information that you displa
For information on changing the level of logging information, see Setting Logging 
options on page 18.

7
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Server log error messages

Examine the list of messages logged on the left side of the Enterprise Edge 
Attendant Console server window for information about the problem and com
the message to the list below. Is there a problem with the database?

Error message / Log message Meaning / Action required

Calloc failed in put_tcpip_packet Memory allocation failed. RESTART Serve

Camp Call on Ext - Ext\n, RetCodeText Error on last operation. Refer to Retcode 
messages on page 36.

Cannot close Console Server, until completely 
started

Trying to close Server during initialization. 
Wait until start is completed before closing.

Cannot listen for connections Unrecoverable error. RESTART Server.

Cannot open blocked CLID db file Server cannot find needed file. Check for 
deletion in Server directory. Restart Server.

Cannot open COS array file Server cannot find needed file. Check for 
deletion in Server directory. Restart Server.

Enterprise Edge Attendant Console Application 
connection closed, extension

Attendant component for ext has closed. 

Enterprise Edge Attendant Console Application 
connection opened, extension -

Attendant component for ext has started.

ConsoleServer.ini file not found in Windows 
directory,

Server cannot find needed file.

Could not register server with CTE CTE/CTA not set up correctly. Check 
installation and RESTART Server.

Destination Station too busy LCD display on telephone already in use b
Server. Transfer call to Enterprise Edge 
Message.

Do_tcpip_state_send appears broken TCP/IP protocol stack corrupted. Restar
Server.

Error allocating Lines Server unable to monitor Lines. Check for 
installation errors.

Ext not in transfer query mode Target extension for function in wrong 
mode. Retry operation after checking 
extension.

Incompatible CTE Version found - %s, 
expecting compatibility version (last digit) 
%c",less,CTE_compatibility)

RE-INSTALL Server component after 
removing CTE program from system. 

Incompatible Switch Software Version found - 
%s, expecting DR7 or greater

Upgrade your Enterprise Edge Voice Server 
to DR7 or greater.

Intercom Call - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Table 2: Server component error messages
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Internal Dial - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Invalid Assistant Extension - Ext, Specify a valid/operational extension.

Invalid Backup Attendant extension Specify a valid/operational extension.

Invalid Console Version Install Attendant / Server at same version.

Invalid Extension Ext set in Console Specify a valid/operational extension.

Invalid transfer destination Specify a valid/operational extension.

Join Call - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Link - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

No Active Call Function requested requires Active call.

No B2 Channels found, possible error Installation error. Review Enterprise Edge
setup.

No Lines monitored, cannot operate Check installation and RESTART Server.

No Stations monitored, cannot operate, Check installation and RESTART Server

Outside Dial - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Outside Dial - Invalid line prefix code, Check installation and retry.

Overflow Call - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Page acquire - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36

Page release - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Park Call - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Pick up trunk - invalid line - ID, Check installation and retry.

Pick up trunk - No calls on Line ID Caller may have just hung up. 

Query Station Status never returned Check status of Station.

Retrieve Parked Call - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Startup failure Server cannot operate Check installation and RESTART Server.

Transfer Call - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

Error message / Log message Meaning / Action required

Table 2: Server component error messages
P0908543 Issue 02 Enterprise Edge Attendant Console Set Up and Operation Guide 



36  Troubleshooting

 

e 

 

ion 
Transfer Call to Voice Mail - Ext\n, 
RetCodeText

Error performing call. Refer to Retcode 
messages on page 36.

Trunk Call, hold - Ext\n,RetCodeText Error performing call. Refer to Retcode 
messages on page 36.

RetCode message Meaning / Action required

ME_ALREADY_ACTIVE The device is in the process of being monitored.

ME_ALREADY_MONITORED The device is already monitored.

ME_BAD_DN Either pDeviceName contains invalid characters, or
the device does not exist.

ME_BAD_PARAMETER An invalid parameter is passed to the API.

ME_COMMAND_FAILED The reason Enterprise Edge has provided for the 
failure is not recognized by CTE.

ME_DEVICE_NOT_RESPONDING A system time-out occurred.

ME_INVALID_DEVID The supplied device Id is not valid.

ME_NO_AVAIL_DEVID No additional devices can be monitored.

ME_NO_FREE_INTERCOMS No button is available to initiate the page on.

ME_NO_INTERCOM_AVAILABLE No intercom keys available.

ME_NO_STATE_MEMORY There are too many outstanding monitor requests 
(the default maximum is 4 outstanding requests).

ME_NO_SYSTEM_SUPPORT CTE cannot execute this API on a Enterprise Edg
Server release prior to DR7.

ME_NOT_ACQUIRED CTE is not involved in a session with deviceId.

ME_PAGE_DENIED Paging is disabled through the Enterprise Edge 
Server admin for deviceId.

ME_PAGING_BUSY A page is already being made in the specified page
Zone.

ME_QUERY_FAILED The request for line pool information failed.

ME_SESSION_SUSPENDED CTE cannot execute this command while the sess
is suspended.

ME_TIMEOUT A system time-out occurred while querying line pool 
information.

Table 3: Retcode messages

Error message / Log message Meaning / Action required

Table 2: Server component error messages
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Troubleshooting Attendant component installation
This section describes solutions to problems that can occur while you install t
Attendant component.

Example - Socket Error on Attendant component start

Initial Action

The Attendant component displays a Socket Error message when you try to start 
the component.

Response

TCP/IP address is not specified on a stand-alone system or TCP/IP is not ins
in the Windows operating system. Install TCP/IP and restart the Attendant 
component.

Example - Attendant component verification procedure does not work                                                             

Initial Action

The Attendant component installation is complete but some of the verification
procedures do not work.

Response

Check the Enterprise Edge Attendant Console Server window to see that the Status 
of Server Program indicates Running. Check for LAN connectivity between the
Server PC and the Attendant PC through the use of Network Neighborhood. C
the Enterprise Edge server installation to ensure that extensions are defined 
correctly.

Example - Enterprise Edge Message extension not working

Initial Action

The Enterprise Edge Message extension cannot be dialed from the Attendan
window.

Response

To access the Enterprise Edge Message system, click the VM Transfer  button and 
enter your mailbox number.
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Error Message / Log Message Meaning / Action Required

A target is required Check contents of Target box for validity.

Cannot transfer a call to self Target field equals the Attendant extensio

Invalid Attendant Extension, Attendant 
Extension not changed

The Attendant extension entered is invalid. 
Choose a valid extension.

No Active call on Attendant No Loop button is in the Active state. Make
Loop active and retry.

Not all the search results could be displayed, 
because there were too many matches. Please 
use a more restrictive search

Edit Employee or Caller function: Find 
argument is too broad. Restrict argument 
and retry. 

Not Enough licenses available on Server All Attendant licenses on the server are 
used. Check that you are attached to the 
correct server.

Please close the Enterprise Edge Attendant 
Console application and reopen it to log in to the 
new server

Shutdown the Attendant component and 
restart.

Server Message: Answer Offered Call 
ME_DEVICE_NOT_RESPONDING

The telephone is busy with Enterprise Edge
configuration.

Socket Initialization Error TCP/IP or network problem. Restart the 
Attendant and retry.

The Enterprise Edge Attendant Console 
application could not open ""att.dir"" file

RE-INSTALL the Attendant component.

The Reports package could not be found RE-INSTALL the Attendant component.

The server did not respond. Please try again The Server component did not respond
the last operation Attendant request. Check
that the server is running.

The system is low on available memory Some functions may not perform properl

The target must be an extension For this operation the Target MUST be a
valid extension.

Version/Release does not match server Check that the server ID is the correct o
If it is, install the matching version of the 
Attendant.

Table 4: Attendant component error messages
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Logging Attendant activity
You can create an Attendant log file that lets you examine the Attendant log f
problems at any Attendant PC.

To create an Attendant log:

1. On the Attendant window, click the Tools menu and then click Log to file.
A check mark appears beside the Log to file command. The Attendant log
is now saved on the disk.

To stop saving the Attendant log file to disk:

1. On the Attendant window, click the Tools menu and then click Log to file.
The check mark is cleared and the Attendant activity for the PC is no long
saved.
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Troubleshooting the Reports component
This section describes solutions to problems that can occur while you install t
Reports component.

Example - Reports window does not open

Initial Action

The Enterprise Edge Attendant Console Reports window does not open whe
click Reports from the Tools menu in the Attendant window.

Response

Check that you can open the Reports component from the Start button on the
Windows taskbar. Click Start, point to Programs, point to Enterprise Edge 
Attendant Console and then click Reports.

Error message / Log message Meaning / Action required

The date string which was entered 
could not be processed!

The date or the format of the date is not valid.

This error occurs if you enter invalid data in either the 
To or From date boxes.

Examples of valid date formats include:

    10/24/73 (assumes 1973)
10/24/1973
October 24, 1973
24 October 1973

An invalid date range was specified. 
The “To” date must be a date which 
occurs later than the “From” date. 
The previous valid date has been 
reset.

This error occurs if:

• The From date is set and a To date earlier
than the From date is entered.

• The To date is set and a From date later 
than the To date is entered.

If this error occurs, the incorrect date is not changed. 
Both the date and edit box are set back to the last vali
value (which is blank if the box had been set to blank)

Reports could not connect to the 
chosen database.

This error occurs if the Reports component fails to 
create a DAO record set from the database selected. 
This can be because:

• The file is not found.

• The file cannot be locked because it is in 
a write protected area.

• The file is not readable for some other 
reason.

This error can also result if DAO is not properly 
installed.

Table 5: Reports component error messages
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The Reports component was unable 
to generate the listing from the 
database specified.

Make sure that the database selected is created by th
server.

This error occurs if a user tries to use the Employee o
Customer directories after connecting to a database th
is not a Enterprise Edge Attendant Console database.
The error is usually proceeded by a message from the
Microsoft Jet database engine stating: “The Microsoft 
Jet database engine cannot find the input table or que
‘People’. Make sure that it exists and that its name is 
spelled correctly.”

The animation file used to indicate 
that a report is running could not be 
found. It might be missing or 
corrupted. As a consequence, no 
animation plays while the reports are 
running.

This error occurs during Reports start if the “run.avi” 
file is not found in the Reports path. Check that the file
is installed correctly and is not deleted. The componen
runs, but the animation does not play while generating
reports.

The maximum number of selections 
allowed in any single category is 100. 
Please limit your selections or cancel 
the selection and choose the “All” 
option.

The maximum number of selections from the 
Customers or Employee categories is 100 each. Tryin
to choose OK from a directory dialog box with any 
more than 100 selections causes this error and return
the user to the directory dialog box to reduce the 
number of selections.

The report could not find the 
necessary data in the specified 
database. Make sure the specified 
database is a valid system database:

This error occurs if a report is run, but the database 
selected is not a valid Enterprise Edge Attendant 
Console database. The colon is followed by a new line
on which a more specific error message from the 
Crystal Reports Engine is displayed. This message is 
usually “Unable to connect: incorrect table location”.

Reports could not find the needed 
report (.rpt) file. Make sure all the 
“.rpt” files are installed correctly.

This occurs when generating a report, if the appropriat
“.rpt” file is not found in the Reports directory. Either 
the file is deleted, moved, not installed correctly or 
corrupted. When corrupted the Crystal Engine can no 
longer recognize it as a.rpt file even though the name 
indicates it is.

The report file has somehow become 
corrupted. The following statement in 
English is more detailed information 
useful for troubleshooting.

This error occurs if the needed “.rpt” file is found but 
does not contain the correct parameter fields or 
information. The Extension Directory Report (using 
ExtDir.rpt) does not produce this error because it does
not require any parameters.

The “statement which follows” part occurs on the next
line and is a message from the Crystal Reports Engine
Unfortunately, it is most often “No Error”.

Error message / Log message Meaning / Action required

Table 5: Reports component error messages
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External Errors

The DAO, MSJet1, and Crystal Reports2 DLLs sometimes post error messages t
the screen when errors occur. These error messages are always be followed 
of the above error messages.

Reports could not draw the desired 
report to the window. This could be 
caused by a lack of windows 
resources or a missing engine 
component. Please close other 
applications that are running and try 
again. Also make sure that no needed 
DLL's have been deleted.

This error occurs if, during the generation of the report
the Crystal Reports Engine cannot complete the repor
and display it. The two main causes are, in order of 
most common first:

1. A required DLL is missing or not installed 
correctly. (99% of the time)

2. Windows is low on GUI resources.

Reports could not lock the database. 
In order to lock the database, the 
database cannot be in a read-only 
location. Please make sure that the 
database is not in a read-only folder 
or drive and try again.

This error occurs if the database reported on is in a 
read-only location on a shared drive and one of the 
directory buttons is used.

1. DAO and MSJet are trademarks of Microsoft Corporation.
2. Crystal Reports is a trademark of Seagate Information Management Group Inc.

Error message / Log message Meaning / Action required

Table 5: Reports component error messages
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Glossary

Assistant attendant

The assistant attendant provides call coverage for one or more extensions 
connected to the Enterprise Edge server.

Attendant PC

A personal computer used to run the Enterprise Edge Attendant Console Atte
component. To operate, the Attendant PC must be connected to an Enterprise
server.

Backup attendant

The backup attendant receives calls if the main attendant is not available to a
calls. The main attendant uses the Out button on the Attendant window to ind
they are not available.

Caller ID

A service available from the telephone company that displays the caller’s 
telephone number and in some cases the caller’s name on the display of a 
telephone. If your company subscribes to Caller ID and has Enterprise Edge 
Attendant Console installed, the Attendant window displays the caller’s name
telephone number.

CTE

Computer Telephony Engine.

Enterprise Edge Attendant Console

Enterprise Edge Attendant Console is a Windows®-based software application tha
provides call management and call activity reporting capability to a business.

LAN

Local Area Network. A group of computers connected together to access 
information and services in a common environment.

Main attendant

The telephone attendant who is primarily responsible for managing a compan
incoming calls.
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Networked model

A way of configuring Enterprise Edge Attendant Console so that one or more
Attendant components are connected to the Enterprise Edge server through a

Overflow attendant

The overflow attendant handles the excess calls when the main attendant rec
more calls than can be handled by an Attendant window.

Server ID

The TCP/IP host name of an Enterprise Edge Attendant Console PC.

Server PC

A personal computer used to run the Server component. In some Enterprise 
Attendant Console models, the server PC runs the Attendant component and
Reports component.

Server component

Part of the Enterprise Edge Attendant Console software. The Server compon
communicates with one or more Attendant components.

Service

The ability of a Windows NT machine to start a process, usually automated, w
the machine is started.

Taskbar

The area on the bottom of the desktop that contains the Enterprise Edge Atte
Console taskbar buttons.

TCP/IP

Transmission Control Protocol/Internet Protocol. The communication protoco
used by Enterprise Edge Attendant Console to communicate between the Se
component and the Attendant components. The industry standard communic
protocol for communication between computers.
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